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chapter 1 :  computer Languages 

A. 1 b 2 c 3 b 4 a 5 b B. 1 Program 2 Machine Language  3 
High Level Language 4. Compiler 5. LISP  C. 1. F  2. F T. 3. T 
4. T 5. T D. 1.  Computer Language can be classified into the 
following categories : (i) Machine Language  (ii) Assembly 
Language (iii) High Level Language (iv) Fourth- Generation 
language  2. (i)  It is also called First Generation Language. 
(ii) It is only Language which computer understand. (iii) 
It is expressed in binary form (o and 1), where 0 means 
'Off' and '1' means 'On' 3.  Compiler is a type of translator 
program which is required to convert a high level language 
progam into machine language. A compiler translates the 
entire program in one go, i.e, it  produces the object code 
for the progam as it generates the list of errors.  4. These 
types of language are close to human lanuguage. (ii) It is 
user friendly and independently of any operating system. 5. 
Machine Language. (i) It is first generation Language  . (ii) It 
is expressed in binary co & 1. (iii) It has a high speed and 
very low memory usage.  Assembly Language (i) It is second 
generation Language  (ii) It uses numeric codes or symbols. 
(iii) It has to be connected to machine Language to work  E. 
(a) Assembly (b) Compilers (c) Interpreter (d) Machine  (e) 
Binary.  

chapter 2 : ms Word 2013: using maiL merge

A. 1. a 2. a 3. a 4. c B. 1. Tab 2. Tick 3. Recipient List 4. 
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Field 5. Viewing C. 1. F 2. T 3. F. 4. F 5. T  D. 1. Mail merge 
is a feature which is used to combine a data source with 
the main document. It saves much of time  and efforts. 2.  
Data source Main Document, Merge field 3. •Data  source 
contains mailing lists. For example, name, address, city, PIN, 
mobile number etc. •  The data is organised in the form of a 
table along with the field names. •The data source is related 
to the main document. Therefore, its fiels names can be used 
in the document which makes it easier to merge address 
along with the main document 4. Step 1: For creating a 
new mailing list, Type a new list select radio button in the 
mail merge task pane and under Select recipients section. 
Select the create option. The New Address list dialogbox 
will appear on the screen. Steps 2: Click on the Customize 
Columns button to add or remove fields. Step 3: Enter the 
data in the given fields. Click on the new entery button. 
You will get a save address list dialog box. Steps 4: Enter 
three records of your friends. You will get a save address list 
dialog box. Steps 5:  Give a name in the file name: text box 
and click on the Save button. 5. Printouts of your letter can 
be taken with the merged data of your data source. Follow 
the steps given below to prints the letters: Steps 1: Click 
on the Finish & Merge button in the Finish group on the 
mailings tab. Click on the Print Documents option from the 
drop-down menu. •The Merge to Printer dialog box appears 
on the screen. Specify the required print settings. click OK. 
•Step 3 : The Selected records get printed separately along 
with the letter.
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chapter 3 : microsoft poWerpoint 2013 

A. 1. a 2. a 3. b 4. a 5. a  B. 1.table  2. table style 3. Alignment 
4. Top 5. Data sheet  C. 1. F 2. T 3. F 4. T 5. F D. 1.  To 
intertion of table, Follow the given steps: Step 1 Click on 
New Slide drop down arrow on Home tab add select Title 
and content layout. Steps 2: Select Insert Table icon present 
on the slide. The Insert Table dialog box will be displayed. 
Steps 3: Specify the number of columns and rows then click 
OK. or Click Insert tab → Table → Draw Table option. 2. 
Select rows/columns/cells → Click on Border (in the Table 
Style group on Design tab)→ Select All Borders option (from 
drop down menu) 3. Six alignment buttons are present on 
the tab-Align Text Left, Center, Align Text Right, Align Top, 
Center Vertically and Align Bottom. 4. Selecrt table → Click 
Design Tab → Select rows or columns → Shading option (in 
Tabl3e Styles group) → Select a colour. 5. Chart is an efficient 
method for depicting data in a graphical or pictorial form. 
They make the display of  comparisons, growth, relationships 
among data very easier. When a chart is inserted, the data is 
shown  in a special window known as datesheet.The charts 
gets automatically updates with any change in the data.  

chapter 4 : animation of text amd objects

A. 1. (a) 2. (c) 3. (b) 4. (a)  5. (a)   B. 1. Transition effects 2. 
Action buttons 3. Speaker 4.  Animation 5. Action C. 1. F 2. 
T 3. F 4. T 5. F D. 1. Animation is the ability to move text , 
graphic, charts etc in the direction of the slide that you like. It 
is useful when you want to emphasize on certain part of your 
presentation and aslo helps in deciding how to information 
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in your presentation flows. Its is possible to animate pictures 
text, shapes and many other objects in powerpoint by using 
sound and visual effects. 2. To adding sound fron file, Follow 
the given steps: Steps 1: Choose the disered slides and click 
on the Audio Menu in the media group of the Insert Tab. 
A dialog box will apears. Steps 2: Choose the required file 
from the desired location and click Steps 3: Now, a speaker 
icon will appear on the slide  and two tabs- Format and 
Playback will also appear under the Audio tools on the 
ribbon. Steps 4: Choose either Automatically or on click 
fromthe drop down menu of the start field in the Playback 
Tab. Steps 5: If automatically option is chosen, sound will 
start automatically as the slide appears and if on click is 
chosen, sound will start when you click. Steps 6: Click to the 
speaker icon to play the sound. 3. We can insert a link to 
a web page, file slide in same presentation, slide in another 
presentation etc using by Action Buttons. In -built buttons 
shape that can be used to perform actions a sound, redirect 
to another slides etc are called Action Buttons. clicking such 
buttons will  cause the action to occur. 4. To add transition 
effect follow the given steps: Steps 1: Choose the desired 
slides and click on transitions tab.  Steps 2: You will see 
Transition to this slide group on the ribbion. Steps 3: Click 
more and more choose a transition effect from the options 
to see the current  slides preview the choosen effect. Steps 
4: In the Transition to this slides group, choose effect option 
to choose an effect for the choosen transition.   Steps 5: 
In the Sound option of timing group, Choose any sound 
effect and click on preview to hear the sound. Steps 6: In 
the duration box of the timing group, enter the transition 
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timing or check the on mouse click check box if you want 
to switch to the next slides on mouse click  Steps 7: Chech 
the After checkbox if you want  your slides to move to the 
next automatically. Steps 8: If you want you effect to apply 
to all slides, click on the Apply To All Options. Steps 9 : In 
the  slides shows tab, click on From Begning to view all your 
slides with the applied effects. 5. The steps given below to 
import data from world:  Steps 1 : open Microsoft Word from 
the start menu. Go to the view tab and click on the outline 
button in the Document views group. Steps 2: Types some 
text as given in the image and click close outline view to 
come back to the print layout view. Steps 3: Click on Types 
of computers and go to Home tab to apply Heading 1 from 
Styles group. Steps 4: Choose Supercomputer and apply 
Heading 2. Steps 5: Choose Embedded and apply Heading 
3. Steps 6 : Choose weather forcasting and apply heading 
7. Step 7 : Then, Apply Heading 2 on Mainframe. Similarly, 
Heading 2 is applied on Minicomputer and Microcomputer.  
Steps 8 : Click Save on Quick Access Tollbar. You will see that 
a save as dialog box appears. Write Types of Software in the 
space  for file and close MS word. Steps 9 : Next  open any 
existing presentation in MS Powerpoint. Go to the view tab 
and select the slide sorter button. Steps 10: Go to the Home 
Tab and  Choose the slides from Outline option from 
the menu that appears. Steps 11 : You will see that an insert 
Outline dialog box appears. Locate the place where the word 
file types of Software is stored.  Steps 12: Choose the file  
and click on Insert. Step 13: You will see the new slides will 
get inserted displaying text in the style that you choose and 
applied.  
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chapter 5 : microsoft exceL 2013 

A. 1. a 2. b 3. b 4. b 5. b   B. 1. Workbook 2. Workbook  
sheet  3. Formula    4.  Range 5. Cell  C. 1. F 2. F 3. T 4. F  5. 
F  D. (1) Workbook is the first window which is displayed on 
the screen. By default, it is named as Book 1. • A workbook 
is similar to a notebook that contains a lot of pages. A 
workbook contains pages. A workbook contains pages similar 
to a notebook. These pages are known as worksheets.  2. Cell 
:- It is an intersection of a row and a column in a worksheet. 
Each cell in a worksheet has  a cell address. For example, E6 
refers to intersection of column E and row 6. Active cell :- A 
thick black border will appear around a cell if you click if 
you click it. It shows that it is the active cell. This highlighted 
box is also known as cell Pointer. Data can be entered only 
in a cell that has the pointer.  3. (1) Workbook is the first 
window which is displayed on the screen. By default, it is 
named as Book 1. • A workbook is similar to a notebook 
that contains a lot of pages. A workbook contains pages. 
A workbook contains pages similar to a notebook. These 
pages are known aas worksheets. • A worksheet is where 
you can enter your data.  An Excel workbook shows three 
worksheets at the bottom, by default They are named as 
Sheet1, and Sheet 3. We can Add more worksheets well.  4. 
Renaming a worksheet: For renaming a worksheet, double-
click on the Sheet tab that has to be renamed, type in the 
new name and press Enter. 5. Microsoft Excel supports the 
following  data types- •Numbers •Text •Formula
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Number Value which contain numerals from 0 to 
9 and characters like +, -, !, @, &, ^ etc. 
used for calculations.

Text Contains alphabet+-s, numbers, space 
and specials characters. Not used for 
calculations. By default left aligned.

Formula Mathematical equtions that constist of 
number values, operators and cell address 
used for doing calculations in worksheet. 
Being with equal (=) sign.

 chapter 6 : Learning to edit a Worksheet

A. 1. c 2. b 3. b 4. c 5. c  B. 1. Format 2. Edit 3. ?? 4. 
Space 5. Autofill C. 1. F 2. F 3. T 4. F 5. F  D. 1. Edit Mode 
Step 1 : Choose the cell E7 and double-click inside it. You 
will see that the value is displayed in the formula bar. Step 
2: The point of insertion will blink in the cell. Step 3: Also 
observe that the left side of status bar shows the Edit mode. 
Place your arrow to the required location and modify the 
data. Steps 4: Press enter and you will see that the changes 
are made. Also, Edit mode will change to ready mode.   2. 
Sometimes, after making changes to a cell, we may want 
to undo option of the quick Access toolbar to undo our 
last action. If we wish to repeat the last action that we did 
using undo command, we can use the redo command of 
the Quick Access Toolbar. 3. Choose the First row /column 
and then select the others while simultaneously holding 
down the ctrl key. 4. A using Drag and Drop method Step 1: 
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Choose the desired group of cell and take your mouse arrow 
to the edge of the choosen cells. Steps2: Your arrow will 
change to a move pointer symbol. Steps 3: Next, drag the 
group of cells to the desired and released the mouse. You 
will see that the data has been moved. 5. Auto Fill Features 
of MS Excel can used to fill the cells with data aurtomatically. 
To use this Feature, follow the steps given below: Steps 1: 
As an example, write Monday in cell F1. Steps 2: Take your 
mouse arrow to the lower right corner of the F1 cell. Steps 3: 
You will observe that the arrow changes to a "+" cross. Steps 
4: Hold the left button of the mouse and drag till cell F7. 
Release the button. Steps 5: You will see that days Monday 
to Sunday will appear in the cells F2 to F7.  

modeL test paper-i

A. 1. b 2. b 3. a 4. a 5. b B. 1. Machine Language 2. Cell  3. 
Table  4. Speaker    5. Workbook  C. 1. T 2. F 3. T 4. F 5. F  
D. 1. Machine Language. (i) It is first generation Language  . 
(ii) It is enpressed in binary co & 1. (iii) It has a high speed 
and very low memory usage.  Assembly Language (i) It is 
second generation Language  (ii) It uses numeric codes or 
symbols. (iii) It has to be connected to machine Language to 
work. (2). Cell :- It is an intersection of a row and a column 
in a worksheet. Each cell in a worksheet has  a cell address. 
For  example, E6 refers to intersection of column E and row 
6. Active cell :- A thick black border will appear around a 
cell if you click if you click it. It shows that it is the active 
cell. This highlighted box is also known as cell Pointer. Data 
can be entered only in a cell that has the pointer. (3).   To 
intertion of table, Follow the given steps: Steps: 1 Click 
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on New Slide drop down arrow on Home tab and select 
Title and content layout. Steps 2: Select Insert Table icon 
present on the slide. The Insert Table dialog box will be 
displayed. Steps 3: Specify the number of columns and rows 
then click OK.  or Click Insert tab → Table → Draw Table 
option. (4). We can insert a link to a web page, file slide in 
same presentation, slide in another presentation etc using 
by Action Buttons. In built buttons shapes that can be used 
to perform actions a sound, redirect to another slides etc. 
are called Action Buttons. clicking such buttons will  cause 
the action to occur. 5. Renaming a worksheet: For renaming 
a worksheet, double-click on the Sheet tab that has to be 
renamed, type in the new name and press Enter. 

   

chapter 7 : aLgorithm and fLoWchart

A. 1. b 2. a 3. b 4. a 5. a  B. 1. Flow chart  2. Algorithm  3. 
Decision 4. Start stop 5. Flow lines C. 1. T 2. F 3. T  4. F 5. 
F  D. 1.  An  algorithm is a set of sequential steps that are 
needed to solve any mathmatical or a logical problem. It is 
always written in a simple language with a precise manner, 
so that such it is easily understood by everyone. 2. (i) 
Decision Box  Used for checking / applying a condition.  3. 
A Flow chart refers to the pictorial representation of steps or 
an algorithm that is used for solving a specific problem. For 
creating a flowchart, various boxes are made use of, that are 
connected with each via flow lines. 4. Input/Output Box is 
used for taking or giving output 5. Flow lines or Connection 
lines Shows direction of program flow.
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chapter 8 : an introduction to qb64
A. 1. a 2. a 3. b 4. b & c 5. b B. 1. constant 2. Bracket, 
exponential, Division, Multiplication, Addition and 
Substraction 3. numbers 4. ?? 5. print C. 1. F 2.T 3. F 4. F 
5. T D. 1. QBasic was developded by mathematical to type, 
edit and run a programs. Basic has english like words and 
mathatical symbols for writing programs and the various 
instrucrtuions in QBasic are called statements. Syntax is the 
set of rules that must be followed while writnig programs 
in a language. QB64 update version of QBasic. 2. A named 
memory location which is used to store information temporily 
and continues to hold this value till some other value is 
given it is called a variable. This variables are two types: 
(i). Numeric Variables: A numeric variable can be used to 
store a numeric value and is shown as an alphabet followed 
by another alphabet or a digit. This variable should not 
contain any special character or space. If we want a variable 
to consist of two seperate words, you can use underscore 
instead of space. Example of  numeric variable are B, GHt, 
Ht_Iu etc. (ii) Alphabet or string Variable: An alphabet(s)or 
digit (s) or underscore followed by a dollars($) sign is used 
to represent a string variable. Example of string variables are 
A1$, pkjh$, ASB2$. 3. Numeric constants: A number  that 
is integer or a real number, positive or negative is called a 
numeric constant are : 230, 12, -13.. Calculations are done 
using these constants and thus, should not have any special 
character. (ii) Alphanumeric or string constants: String is a set 
of characters and string constant constist of many characters 
from A-Z, a-z, 0-9 and many special symbols like &, #, * 
etc. String must be put in double quotes, Such constant 
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represents non  numeric quantities and some example 
are "SUM=66" , "216726" etc. 4. The  sequence in which 
operations are performed in a QBasic expression is called 
Hierarchy of operations. We use the BEDMAS hierarchy of 
operations. 

   Example: Solve The Expression: 

 12*4+(14+4) + 2^2 - 12/6 (First bracket will be solved)

 12*4 + 18 +2^2 -12/6 (Then, exponentiation will be 
performed)

 12*4 + 18+4 - 12-6 (Now, Division will be performed )

 12*4 + 18 + 4 - 2 (Then, multiplication will be 
performed)

 48 + 18 + 4 - 2 (Then, addition will be performed)

 70 - 2 (Now, Subtraction will be 
performed)

 68 This is the answer

 5. To save a program, follow the given steps: Steps 1: Go to 
the File menu. STEPS 2: Choose the Save As option. Steps 3: 
Give the name you want to your program by writing in the 
space bar file name and press Enter.  Steps 4: Your file will 
be saved with extension .bas.

chapter 9 : qb64 statement

A. 1. b 2. b 3. a 4. b  B. 1. Question 2. table 3. Input 4. 
numeric 5. CLS C. 1. F 2. T 3. T 4. T D. 1 It is used to take 
a data item from the user and then store it in a variable. 
It also ask the user to enter data by displaying a question 
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mark (?) on the screen during the execution of values abd 
then presses the Enter key. Syntax: INPUT<Numeric or String 
Variable Name> Example: INPUT A An INPUT statement can 
be have a list of  variable but they have to be seperated 
by commas. The corresponding values which you enter also 
have to be seperated by commas. 2 It is used to move the 
position of the print to the column specified by its argument. 
It is mostly used for printing tables.

Syntax: PRINT TAB (C); "CONSTANT/Variable/Expression" 
Where C is the column number PRINT TAB(15);"Hello World" 
This will print Hello on the screen, 15th column onwards. 
3. The LET statement or the assignment statement assign 
a value to a variable. Its use is optional. Syntax: [LET] < 
Variable Name >=< Value or Expression> LETX=3

(It will assign the value 3 to x) This statement will multiply 
the values of X and Y and assign the result to variable Prod. 
X$= "HELLO" to the variable "X$". 4. Print with semicolon 
displays the variable one after another without leaving any 
space in between. Syntax: PRINT (Variable); (Variable):...

 LET A$="I"

 LET B$ ="LIVE"

 LET C$= "IN"

 LET D$= "INDIA"

 LET A$;B$;C$;D$

 PRINT A$; "";B$;"";C$"";D$

 END

 Print with comma (,) Its displays the values one after 
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the other with a lot of spaces in between (usually 14).You  
can print only five value in a time. If you want to print more 
than five value, they are printed on the next line. Syntax: 
PRINT(Variable), (Variable)... 

  LET  A= 40

  LET B=60

  C =A+B

  PRINT A, B, "SUM", C

5.  Syntax: PRINT(Variable), (Variable)... 

  LET  A= 40

  LET B=60

  C =A+B

  PRINT A, B, "SUM", C

chapter 10 : Log on fLash cs3 

A. 1 b 2. a 3. a 4. a 5. a  B. 1. Stage 2. Menu Bar 3. Timeline 
4. Frame 5. Ink bottle C. 1. T 2. T 3. T 4.F 5. T D. 1. • Flash 
is an animation software package. •7 It provides aneasy way 
to create animations. •It is a popular tool which helps to 
add animation  and interactivity in websites. • Animation 
and graphics created can be scaled to any size  without 
loss  of clarity or quality. 2. The stage: It is a rectangular 
workspace area where the contents are placed or drawings 
and movies are created. The stage size is 550 × 400 pixels 
by default.  3. (i) Rectangle Tool : It is used for creating and 
other rectangular shapes. This tool includes an option  that 
can be set for making a rounded rectangle. (ii) Polystar Tool 
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: It is used to draw a polygon as well as figures.  (iii) Line 
Tool : It works on the same way as the line tool in graphics 
software. It is used to draw straight lines.   4. Paint Bucket 
Tool : It is useful for filling enclosed areas of an object with 
colours in a single click. For the ares which are not completly 
enclosed. the Paint Bucket Tool can be used. Modifiers are 
available to close the gaps in the shape outlines.  5. Follow 
the steps given below: Steps 1: Click on Start button. Steps 
2: Choose All Programs. Steps 3: Click on the adobe Flash 
CS3 Professional. The Flash screen will be displayed Select 
Flash File (Action Script 3.0) Under New option. It wiil open 
a new blank file. 

chapter 11 : WorkingWith fLash cs3

 A. 1. c 2.c 3. a 4. c 5. a B. 1. Symbol 2. Shape 3. Library 4. 
Motion, Shapes tween 5. Motion quide tween C. 1. T 2. T 
3. F 4. F 5. T D. 1. Symbol is reusable object used for static 
images or animation. Symbol can either be created with the 
help of drawing tools or they can be imported from other 
sources. Symbols are stored in the library. When a symbol is 
placed on the stage, an instance of that symbol is created. 2. 
Instance is basically a copy of the original symbol. The size, 
colour, shape and position can be changed without having 
any affect on the original symbol. 3. Whenever a series of 
image are displayed at fixed intervals of time, there is a sense 
of movement created. This is known as animation. In Flash, 
animations can be created with the help of Tweening, that 
means-'in between'. The movement from one keyframe to 
another gets easier by use of Tweening method. 4. Motion 
guide is used to define the path of the movement of an 
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object. When we apply Motion Guide, a new layer is added 
which is known as motion Guide layer. Whatever is drawn in 
this Motion Guide layer is invisible in  the final animation. 
5. In Flash, animations can be created with the help of 
Tweening, that means-'in between'. The movement from one 
keyframe to another gets easier by use of Tweening method. 
There are two kind of Tweened method. (i) Motion Tween (ii) 
Shape Tween .  Both the Tweening methods just in the facts 
that Motion Tweening works on symbols, whereas Shapes 
Tweening is used with objects which are not symbols and 
are ungrouped. 

chapter 12 : internet service 

 A. 1. a 2. a 3. c 4. a 5. c B. 1. Network 2. video comprencing 
3. skype 4. signature 5. forward C. 1. F 2. F 3. F 4. F 5. F D. 
1. A signature is a personalised text (like contact number) 
whiuch is always added at the end of every e-mail you 
send. 2. Nowadays, Internet offers us various websites to 
stop for clothes, books, furniture, movie, rail and air tickets 
and even our monthly groceries online fron the comfort of 
our homes and offices. It is also possible to see and buy 
2nd hand goods using various websites like olx.com Other 
popular websites for online shopping are www.ebay.in and 
www.flipkart.com. 3. E-Mail is short for Electronic Mail and 
can be used to create, save, send and recieve, messages to 
anywhere in the world. Sending an Email is simple, convenint 
as well as instant and has transformed traditionals system of 
sending and recieving letter through post. 4. Conservation 
between computers over the internet in which message are 
instantly sent and received is called chatting. We can chat 
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through instant messengers, chat rooms, websites etc on the 
Internet. Also, messages can not only be in the form of text 
but we can also send video and audio messages through the 
Internet. Google talk, Skype etc are some popular chat which 
can be easily downloades from the Internet and then an 
account can be created to start chatting. 5. Nowadays, it is 
even possible to perform bank transactions online from the 
comfort of our homes and offices. This is called E-Banking 
and can be used for checking the amount in our account, 
applying for loans, transfering money from one account, 
appliying for loans, transferring money from one account to 
another etc. And  the best part is that these facilities can be 
availed from any part is these facilities can be availed from 
any part of the world and all you need is a computer and 
an Internet connection!.     

modeL test paper-ii

A. 1. b 2. b 3. a 4. a 5. c B. 1. Decision 2. Bracket, Exponential, 
Division, Multiplication, Addition, Subtstraction. 3. Frames  4. 
CLS  5. Network  C. 1.T 2. T 3. T 4. F 5. F D. 1. Flow lines 
or Connection lines Shows direction of program flow..    2.  
QBasic was developded by microsoft to type , edit and run 
Basic has english like words and math,atical symbols for 
writing programs and the various instrucrtuions in QBasic 
are called statements. Syntax is the set of rules that nust 
be followed while writnig programs in a language. QB64 
update version of QBasic. 3. The stage: It is a rectangular 
workspace area where the contents are placed or drawings 
and movies are created. The stage size is 550 × 400   4. 
Syntax: PRINT(Variable), (Variable)... 
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  LET  A= 40

  LET B=60

  C =A+B

  PRINT A, B, "SUM", C

5. E-Mail is short for Electronic Mail and can be used to 
create, save, send and recieve, messages to anywhere in 
the world. Sending an Email is simple, convenint as well as 
instant and has transformed system of sending and recieving 
letter through post. 

  
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Teacher's Manual
Computer with Frolic (Class-7)

chapter 1 : number system

A. 1. a 2. a 3. a 4. a  5. a B. 1. Ten 2. Position 3. 0-9, A-F 4. 0, 
1 5. binary data C. 1. F 2. F 3. F 4.  F 5. T D. 1. For converting 
a decimal into its equivalent binary number, follow the setp 
given below: Step 1: Divide the decimal number by 2 (Base 
2). Step 2: Note down the remainder and then divide the 
quotient again by 2. Step 3: Continue repeating step 2: Until 
the quotient becomes zero. Observe the example given 
below to understand the conversion of Decimal number 
into its Binary equovalent Thus (67)10 = (110001)2. 2. The 
binary Number is based only on two number-0 and 1. Its 
base it 2 as it uses only two numbers. This number system is 
used by all the digital computer which convert the decimal 
data input to binary data. The data enter into a computer 
has to be convert into binary data as the computer can 
not understand human language. The binary data is again 
converted into decimal data for output.  3. The Octal number 
system is composed of 8 digits(0-7) and thus has base 8. we 
can convert an octal number into decimal in the similar way 
as did for binary to decimal conversion. The only difference 
is in the base.

The number system contains 16 digits (0-9 and A-F). Hence 
its base is 16.

4. The process for adding binary number inside the computer 
is simple and easy. Binary addition is similar to addition of 
decimal numbers. The table given below shows all the cases 
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of the addition of two binary digits :

X Y X + Y=Z
0 0 0 + 0 = 0
0 1 0 + 1 = 1
1 0 1 + 0 = 1
1 1 1 +  1 = 10

When we add to 1s, the output will be 10. 0 is written under 
the same column whereas carry over 1 is shifted to the next 
place like in decimal number addition.

Find (1001)2 + (1011)2    Find (1111)2 + (1010)2

    1001
 + 0110
  1111

   1111
 + 0010
  1001

 

chapter 2 : formuLas and function in exceL

A. 1.  a 2. c 3. a  4. a 5. a  B. 1. Basic. 2. Reference  3. 
three. 4. functions. 5. addition C.  1. F 2. F 3. T 4. T 5. F 
D. 1. Formulas are used for doing calculation which involve 
additio, subraction, division and multiplication. It develops 
a relationship between multiple cells. A formula can also 
be defined as the expression that contains cell addresses, 
numbers arithmetic operators as well as parenthsis. Simple 
and complex calculations can be easily performed with the 
help of functions. A formula has to start with equal to (=) sign 
which is followed by the cell references as well as operators. 
2. Step 1: Right click on the Sheet 2 tab in the worksheet. 
Step 2: you will see shortcut menu appears. choose the 
rename option. Step 3: The pointer appears in the Sheet 2 
tab. Type the name of your choice. Press Enter 3. Multiple 
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cells can be assigned to a formula by creating a range or 
reference. It can save a lot of time and effort. If your want to 
find the sum of column or rows, it is most convenient to use 
a range. Step 1: Enter the data as shown in figure select the 
cell C11 and then type = SUM(C3:C9) 4. Absolute reference 
is used when the cell address does not have to be changed 
on copying the formula to another cell. For making absolute 
reference of a formula, add dollar($) sign before the column 
or row number. For example =$B$1+$B$2. 

Follow the steps given below to compute the incentive at 
the rate of 12% on the monthly sales:

Step 1: Type 12% in cell E1. Step 2: Click on cell E3. Step 
3: Type =C3*$E$1. Press Enter.(The first cell address in the 
formula is a relative address and the second one is absolute 
address) Step 4: The incentive value appears in the cell 
E3. Step 5: Now, copy the formula when the pointer gets 
changed to a copy pointer  (+) symbols. Drag this formula 
to the rest of the cells.   

chapter 3 : exceL as database                                  
A. 1. a 2. a 3. b 4. a 5. a B. 1. Database  2. fields(columns), 
records (rows) 3. field 4. field name 5. Data validation C. 1. 
T 2. F 3. F 4. F 5. T D. 1. Database refers to a collection of 
data which is related to a particular subject, like maintaining 
of contact numbers and addresses, a list of books in library, 
maintaining student results etc. The database make it easier 
for the user to organise, retrieve, sort and also edit the data 
according to the requirments. A database contains fields 
(columns) and records (rows). 2. Sorting is the process of 
arrangment of data in the ascending or decending order 
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in a worksheet. you can sort the data present in the rows 
based on text, numbers, combination of text and numbers 
or date. it becomes easy to manage after sorting it. 3. The 
Filter features of MS Excel enables you to have a look at 
only those records which you wish to display. The rest of 
the data is hidden temporarily from the view. The AutoFilter 
command can be used to filter a list for displaying specific 
records- Steps 1: Click on any cell  that is present with in 
the database range, say  C2 Select the Filter button in the 
Sort & Filter group on the Data tab. Steps 2: Small arrows 
get added to every field name. These arrows are required for 
specifying the condition for filtering data. Steps 3:  Click on 
the arrow which is present next to Marks field name.  Select 
the checkboxes with the value 89, 92 and 95 from the drop-
down list. Click OK. Steps 4: The list will be filterd and only 
those records will be filtered and only those will displayed 
which meet the criteria of marks 89, 92 and 95.  4. Data 
Validation is required for resticiting the cell entries within a 
given range. When ever you enter a value beyond the given 
range, an  error message will be displayed. 5. This option 
filters the data in more than one field on the basis of the 
specified criteria, copies the filtered records. 

chapter 4 : advanced features of exceL

A. 1. a 2. b 3. b 4. c 5. c  B. 1. updated. 2.  Category 
name.  3. Plot area. 4. Goal Seek. 5. Gidelines .  C. 1. T 2. 
F 3. F  4. T 5. T    D. 1. Chart is an efficient method for 
depiciting in a graphical or pictorial form. They ease out 
the task of displaying comparisions, growth and relationship 
among data elements. When a Chart is inserted, the data 
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is displayed  in a special window known as DataSheet. The 
chart gets automatically updated with any modification in 
the data.  2. 
Chart Area It include complete area 

and all object of a chart.
Category Axis (X axis) It is the horizantial axis. Has 

the data that is compared 
and presented.

Value Axis (Y axis) It isthe vertical axis. Used 
for plotting values.

3. Bar Chart: It is used to display the data in the form of 
Long roods(known as bars. These rods are placed vertically 
horizontally on the chart area). It depicts the change in data 
over a time span. It also the comparisons among the data 
elements Categories are represented on the vertical axis  
and the values along the horizantal axis. 4. Select the chart 
and follow the steps given below: Steps 1: Select the layout 
tab and choose the chart title option from the labels group. 
Steps 2: Click on the Centered overlay Title or Above Chart 
option. Steps 3: A Chart Title text box will appear on the 
screen. Enter the text in it. Once you  type the title, click 
outside the chart. 5. Goal Seek is an amazing feature of Excel 
that fixes a specific result for one cell by the adjusting a 
value in  other cell Folow the steps given below: Steps 1: 
Type the data in a worksheet. compute the total and the 
percentange as shown in the figure. Steps 2: Click on the 
Data tab and then  select if analysis button in the data 
tools group there choose Goal seek option. The Goal Seek 
Dialog box will be displayed. Steps 3: In Set Cell: text box, 
specify the cell address E5, on which you want to apply the 
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goal seek. Refers the cell which has the formula, in the box.
Steps 4: Enter the new value 130 as a result in To value: 
text box. Press the tab key. Steps 5: Select the cell C4 in the 
worksheet. The address will be displayed in the By changing 
call: taxt box. Step 6: Click Ok. Steps : The Goal Seek dialog 
box will be displayed on the screen showing  the Target 
value 130 and Current value 130. Click Ok. Steps 8: Notice 
the change in the cell C4. The  number gets modified as per 
the percentage which you have set.

chapter 5 : Working With fLash cs3 

A. 1. a 2. c 3. b 4. b 5. c  B. 1. Woprkspace. 2.  Stage. 3. 
Menu. 4. Frames.   5. Timeline. C. 1. T 2. T.  3. T  4. F 5. T  
D. 1. Follow the step given belo to start Flash: Steps 1: Click 
on Start button. Step 2: Choose All Programs. Steps 3: Click 
on the Adobe Flash CS3 Professional. The Flash screen will 
be displayed. Steps 4: Select Flash File (Action Script 3.0) 
under Create New option. It will open a new blank file. 2. It 
is a rectangular workspace area present at the centre where 
the contents are placed or drawings and movies are created. 
The stage size is 550×400 pixels by default. the work Area 
where the contents can be placed abd animated. 3. Tools 
panel has four main parts: The Tools Section: Contains tools 
which are need for drawing, panting and selecting objects. 
The View Selection: Contains tools required for zooming 
and panting the application window. The Colors Selection: 
Contains modifieds for selecting colours for the shape which 
you draw with the helps of stroke and Fill Color picker. The 
options Selection: Displays the modifiers for the tools that 
are currently choosen. 4. Two types of gradients can be 
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created using Flash. Linear Gradient: It changes the colour 
from  to end point in a starting line. Radial Gradient: It 
changes colour in a circular outward direction begning from 
the focal point. 5.  Follow the steps given below: Steps 1: 
Click on File>Import>Import to Stage.The Import dialog box 
will be displayed. Step 2: Browse and choose the file which 
has to be imported. click on open..     

chapter 6 : hoW Layers Works

A. 1. c 2. a 3. c 4.c 5. a  B. 1. Layers. 2. Pencil icon . 3. Logi. 4. 
Onion Skin tool. 5. F6   C. 1. T 2. F 3. F 4 T 5. F D. 1 Layer are 
transparent sheets which are stacked one over the other and 
can hold objects. Layers are used when we are developing a 
big animation film. If you have many objects, then to make 
your work easier, you can divide the various objects amongst 
different layers. Thus, organising of elements of our movie 
like animations etc is made possible by using layers also. It 
is also possiblae to draw or edit  objects of the other layer. 
Only one layers can be activated at one particular time. 2. 
Follow the steps given below to add layers: Steps 1: Simply 
Clicking on the Insert Layer button  of your timeline will 
add a new layer. or Steps 2: Go to Insert>Timeline > Layer. 
Steps 3: You will see a new layer above the chosen layer. 
This new layer is now active layer. Steps 4: Choose Sky as 
the new layer. 3. Layer can be hidden to view objects of 
other layer. We can hide layes individually or all at once. 
Follow the steps below: Steps 1: Above the layers, Click the 
Eye icon and a red cross will be visible in the eye column. 
Also, notice that all content has disappeared from the stage. 
Strep 2: The content will reappear on the layer one by one 
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clicking on each red cross symbol. 4. Follow the steps given 
below to rename a layer. Steps 1: The layer each has to be 
renamed is chosen by clicking on it. Steps 2: The already 
existing name is double clicked and the new name is typed.  
Say the name given is "House". OR . Steps 3: The layer name 
is right clicked and Properties is chosen from the context 
menu. Step 4: A Layer Properties dialog appears. Steps 5: 
The new name is typed in the name text box. Step 6: ok is 
clicked. 

 modeL test paper-i

 A. 1. a 2. a 3. a 4. a 5. a  6. b 7. b 8. b 9. a 10. b 11. a 12. 
a 13. b  14. a  B. 1. 0-9 A f2. Database 3. Three 4. Category 
Name 5. Timeline  C. 1. F 2. F 3. F  4. T 5. T D. 1. Goal Seek 
is an amazing feature of Excel that fixes a specific result for 
one cell by the adjusting a value in  other cell Folow the 
steps given below: Steps 1: Type the data in a worksheet. 
compute the total and the percentange as shown in the 
figure. Steps 2: Click on the Data tab and then choose Goal 
seek option. The Goal Seek Dialog box will be displayed. 
Steps 3: In Set Cell: text box, specify the cell address E5, 
on which you want to apply the goal seek. Refers the cell 
which has the formula, in the box.Steps 4: Enter the new 
value 130 as a result in To value: text box. Press the tab key. 
Steps 5: Select the cell C4 in the worksheet. The address will 
be diusplayed in the By changing call: taxt box. Step 6: Click 
Ok. Steps : The Goal Seek dialog box will be displayed on 
the screen showing  the Target value 130 and Current value 
130. Click Ok. Steps 8: Notice the change in the cell C4. The  
numberr gets modified as per the percentage which you 
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have set. 2. Absolute reference is used when the cell address 
does not have to be changed on copying the formula to 
another cell. For making absolute reference of a formula, 
add dollar($) sign before the column or row number. For 
example =$B$1+$B$2. 

Follow the steps given below to compute the incentive at 
the rate of 12% on the monthly sales: Step 1: Type 12% 
in cell E1. Step 2: Click on cell E3. Step 3: Type =C3*$E$1. 
Press Enter.(The first cell address in the formula is a relative 
address and the second one is absolute address) Step 4: 
The incentive value appears in the cell E3. Step 5: Now, 
copy the formula when the pointer gets changed to a copy 
pointer  (+) symbols. Drag this formula to the rest of the 
cells.    3. Follow the steps given below: Steps 1: Click on 
File >Import>Import toStage.T he Import dialog box will be 
displayed. Step 2: Browse and choose the file which has to 
be imported. click on open.  4. Data Validation is required 
for resticiting the cell entries within a givewn range. When 
ever you enter a value beyond the given range, an  error 
message will be displayed. 5. Layer can be hidden to view 
objects of other layer. We can hide layes individually or all 
in once. Follow the steps below: Steps 1: Above the layers, 
Click the Eye icon and a red cross will be visible in the eye 
column. Also, notice that all content has disappeared from 
the stage. Step 2: The content will reappeared on the layer 
one by one clicking on each red cross symbol.  

chapter 7 : introduction to Wordpad 

A. 1. b 2. c 3. a 4. c 5. a   B. 1. Variable  2. Go to   3. 
Constants   4. Control Statements 5. Integer, Real C. 1. F 
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2. T 3. T 4. T 5. F   D. 1. The statements of a program 
are usually executed in a proper squence. But Sometimes, 
you may require changing the order of execution. You may 
need to repeat certain statements or skip some statements 
on the basis of condition. Control statements are used in 
these situations. They are many control statements in QB64 
such as- GOTO, IF THEN, IF THEN ELSE, etc for performing 
repetitive actions or performing conditional checks. 2. It is 
also called unconditional transfer control. It transfers the 
program control from one statement to another. Syntax: 
GOTO <Instruction> Example: 

X=2 , SRT: , Y=X+X, PRINT Y, X=X+X1, GOTO SRT, END .

 When the GOTO statement is encountered, the control gets 
transfered to the required line for making a loop. If there is 
an unconditional transfer of control, it leaqds to an infinite 
loop that cannot be exited. 3. It is a conditional decision 
making statement. If the condition given after If is found 
to be true, the statement after THEN is executed. If the 
condition is false, the ELSE statement gets executed. Syntax: 
If <condition>THEN<statement2>. 4. Constant are defined 
as the values which do not change the program executes. 
There are two types of constants: Numeric Constants, 
Character constants. Variables: A variable is named location 
in the computer memory which stores some data temporaily 
A variable has a unique name, type and size which help to 
identify the varuiable in a program. It can accept one data at 
a time and can take in different values. (i) Numerical Variable. 
(ii) String Variable. 5. It is similar to input statement. The 
only difference between this statement. The only deifference 
between this statement and INPUT is that INPUT statement 
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needs data at the time of exe3cution of program. Whereas 
the READ-DATA statement can take more than one data at a 
time of executin starts. This saves time as the data is qalready 
present within the program. The type of data Should match 
with the type of variable which is defined in READ statement 
else an erroe message will be displayed.      

chapter 8 : Looping staqtements

A. 1. a 2. b 3. b  4. a 5. b  B. 1. For Next   2. Control   3. ???   
4. Next 5. Initial, Final  C. 1. F 2. F 3. F 4. T 5. F   D. 1. When 
we are writing a program, we might have to execute a set 
of statement multiple times. This can be achieved with the 
help of loops. Example: Suppose we take a control variable 
c. In our program, initially c is 0 and we increment c by 
1 after each round is completed. That is, after first round, 
C=1 After second round ,c become 2 and so on. After 
each round , c is checked against a fixed number say max. 
If c is less than max, another round is taken else, loop is  
teminated. Loops are advantageous because they decrease 
the number of instrucrtion or we write in our program and 
thus save memory space and our time. 2. Using a large 
number of counter variable makes it very large and difficult 
to comprehend. This problem can be solved by using FOR...
NEXT loop which can be used when a set of instructions. 
Syntax: FOR <Control Variable> = <Initial value>TO <Final 
value> Statement(s) Next <Control Variable>.  3. This 
statement is used if we want to increment the value of the 
control variable in FOR...next by something other than 1. 
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PROGRAM 7: TO PRINT THE FIRST 10 EVEN NUMBERS

   CLS

   FOR I=1 TO 20 EVEN NUMBERS

   PRINT I 

   NEXT I 

   END

4. USING ONE FOR...NEXT statement inside another FOR..
NEXT statement is called is called nested FOR...NEXT which 
enclosed the second FOR...NEXT is called outer loop and the 
inside is calleed inner loop. Steps 1: The maximum number of 
loop within loop can be 9. Each must be defined complexity 
inside the outer loop. Steps 2: Control variable used must 
be different loops.  5. GOSUB instructio can be use to jump 
directly to some place in the program. Labels denote the 
position to which jump has to be made and from where 
execution should continue. The GOSUB...RETURN STATEMENT 
is same as GOTO other than when a RETURN statement is 
written. Then, control return to GOSUB instruction. 

 Ex → FOR I =1 TO 10

  PRINT "PLEASE INSERT"

  GOSUB A 

  GOSUB B 

  END 

  A:

  PRINT "SYSTEM"

  RETURN
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  B:

  PRINT "DISK" 

  RETURN

  NEXT 1

  END

 chapter 9 : graphics in qb64

A. 1. c 2. c 3. a 4. a 5. a   B. 1. PSET  2. Line   3. Draw   4. 
Screen 5. Color C. 1. F 2. T 3. F 4. T 5. F   D. 1. It is used 
for specifying the screen resolution. The synatx is: 'SCREEN 
mode parameter'

Many Screen modes can be used in QBasic and QB64. E ach 
mode has resolution and support for different number of 
colours. The table below showa the different screen modes 
along with their resolution  and  also the  number of colour 
that they support-

 Screen Mode  Resolution No. of colours it 
support 

Screen 1 320 × 200  4
Screen 2 640 × 200  2
Screen 7 640 ×  200  16
Screen 8 640  × 200  16
Screen 9 640  ×  350  16 
Screen 10 640  × 350  2
Screen 11 640 × 480  2
Screen 12 640 × 480  16
Screen 13 320 × 200  256
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You can change  screen mode with higher resolution in 
QB64. There are two ways of using the screen modes in 
QB64. 2.The DRAW command draws a straight line in any 
direction on the screen. You can draw a line by using the 
pointer in the middle of the screen. The line is drawn in any 
direction with the use of specific characters. Letter D means 
line is downward   direction, Umeans upwards, Rmeans 
Right and L  means Left. The syntax is: DRAW "DIRECTION 
<Length of direction>"

 Example:
 SCREEN1
 CLS
 COLOR 5
 DRAW "U80"
 END 
3. It can be used for drawing a circle, ellip-se or an arc of 
the circle. The syntax is: CIRCLE (x y), r, p
The coordinates x and y refers to the centre of  the circle 
on the screen, 'r' refers to the radius of the 'p' refers to the 
colour code.
 Example:
 SCREEN 7 
 COLOR 14, 5
 CLS 
 PRINT "A CIRCLE"
 CIRCLE (160, 100), 50, 15
 END
4. There are four types of diagonal statements that can be 
used for drawing lines in different directions diagonally. The 
staetments are-
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Steps 1: E- allows the pointer to draw a line diagonally in 
upward directions and towards the right side.

Steps 2: F- draws a line diagonally in the downward direction. 

Steps 3: G- draws a line diagonally in downward  direction 
towards the left    side.

Steps 4: H- draws a line diagonally in upward direction 
towards the left side. 

5. LINE (X1, Y1)-(X2, Y2), COLOR

Here, (X1, Y1) and (X2, Y2) refers to the starting and editing 
coordinates of the line which is drawn in the colour that is 
specified. 

chapter 10 : service of the internet

 A. 1.  c 2. b 3.  c  4. b 5. a 6. a B. 1. Internet forum 2. 
Blogging 3. 140 4. E-mail 5. One Drive   C. 1. F 2. F 3. F 4. T 
5. F  D. 1 Micro blogging is becoming very popular in which 
users communicate their thoughts and ideas through shorts 
posts which are sent via SMS, email, digital audio, web and 
other online mediums. Twitter and Tumbler are examples of 
such services. 2. When a contract is not needed any more, 
you can delete it from you contacts book. Follow the steps 
below:

Steps 1: Go to you contacts list. Steps 2: Choose the contact 
list. Steps 3: Click on the More drop-down arrow. Steps 4: 
Choose the Delete contact option. 3. Acollection of hardware, 
networks, storage, interfaces and services joined together to 
deliver various services a networl or the internet is called a 
cloud. 
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Email, web conferencing are some applications that run in 
cloud. You may have heared of GoogleDocs Dropbox etc 
which are some free or low cost online cloud storage for 
users.

We can use cloud computing to change, confugure or access 
online applications. Also, cloud computing has resulted in 
a decrease in instance of copright violations and piracy 
beacuse users can now access  authentic content by paying 
very little in a very secure and confidential manner. 4. An 
area for discussion on a website allows people with similar 
interest to share ideas and information is called a Forum. In 
a Forum. In a Forum, people can send and reiceve message 
posted by others on a variety of subjects in a real time. We 
can find forums concentrating on many topics such as Music 
religion, sports, health etc. A user must register himeself on 
the website to  become a member  of the forumand when the 
person is allowed membership, he canset his username and 
password. after sucessful registration, user can post to the 
forum as well as  view point of other members. 5. Microsoft 
offers an online storage facility whis his called Online Drive. 
Online Drive was earlier called sky drive and was renamed 
in 2014 to one drive to signify that it is a single place where 
one can store all their data, picture and videos completely 
free of cost. It also allowd users to choose which they want 
to keep private, make public or share with their contacts. 
The region where users upload and sychronise dat to cloud 
storage is procted by a password. 

chapter 11 : the viruses    

A. 1.  a 2. b 3.  b  4. a 5. a  B. 1. Virus 2. Vital Information 
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Resources under seize 3. Worm 4. Antivirus 5. Scanned C. 
1. T 2. F 3. T 4. F 5. F D. 1. It is type of malware which 
gets installed on computers and then collects data about 
users without their permission. These programs silently 
monitor the user's  computing. They can gather a lot of 
user's personal information like visited web pages, sufing 
habits on internet and then transfers this information like 
visited web pages , surfering habits on internet and then 
transfer this information toi someone else. They can also 
alter the computer settings which can slow down the 
connection speedand also harm other progam. Spywares 
can gather data about e-mail address, passwords etc. 2. It 
is a type of virus that copies and multiplies itself with the 
help of security flaws and  computer networks. They have 
the tendency to overload the network resource that can slow 
down the data transmission speed because thay consume 
a lot of system memory or  network bandwith. 3.   These 
are the type of viruses that can infect the boot record or 
master boot record.They have capability to replace the boot 
record that loads the operating system in the memory of 
the computer, by coptying it somewhere else. These types 
of viruses are usually active when you boot your computer 
system. Stoned virus, Disk Killer are some examples. 4.A virus 
can many problems to a computer. Some of these are: •It 
can reformat the hard disk. •It can show abnormal write 
protected error. • It can delete or damage the files. •It  can 
reduce the speed of the computer system by decreasing the 
computer memory. • 5. They are  the computer programs 
that are developed for identifying, preventing or removing 
the viruses from a computer. They can perform the following 
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tasks in a computer: •Scan all the computer files to find 
viruses. •Try to recognise any kind of suspicious behaviour 
from any computer program which may be an indication of 
an infection.            

modeL test paper-ii

A. 1.  c 2. b 3. b 4. b 5. a B. 1. Vital Information Resource 
under seize  2. Variable 3. Line  4. Blooging 5. Also C. 1. T. 
2.  F.  3. T 4. T 5. F  D. 1. Using a large number of counter 
variable makes it very large and difficul5t to compreherd. 
This problem can be solved by using FOR...NEXT loop 
which can be used when a set of instructions. Syntax: 
FOR <Control Variable> = <Initial value>TO <Final value> 
Statement(s) Next <Control Variable>. 2.  Micro blogging is 
becoming very popular in which users communicate their 
thoughts and ideas through shorts posts which are sent via 
SMS, email, digital audio, web and other online mediums. 
Twitter and Tumbler are examples of such services. 3.  These 
are the type of viruses that can infect the boot record or 
master boot record.They have capability to replace the root 
record that loads the operating system in the memory of 
the computer, by coptying it somewhere else. These types 
of viruses are usually active when you boot your computer 
system. Stoned virus, Disk Killer are some examples. 4.  It 
is used for specifying the screen resolution. The synatx is: 
'SCREEN mode parameter'
Many Screen modes can be used in QBasic and QB64. Each 
mode has resolution and support for different number of 
colours. The table below show the different screen modes 
along with their resolution  and  also the number of colour 
that they support-
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 Screen Mode  Resolution
No. of colours it 

support 
Screen 1 320 × 200  4
Screen 2 640 × 200  2
Screen 7 640 × 200  16
Screen 8 640 × 200  16
Screen 9 640 × 350  16 
Screen 10 640 × 350  2
Screen 11 640 × 480  2
Screen 12 640 × 480  16
Screen 13 320 × 200  256

You can change  screen mode with higher resolution in 
QB64. There are two ways of using the screen modes in 
QB64. 5. 

  
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Teacher's Manual
Computer with Frolic (Class-8)

chapter 1 : netWork concepts

A. 1. b 2. c 3. b 4. a 5. a B. 1. Firewall 2. Hub 3. Lan  4. 
Topology 5.  WORM C. 1. T 2. F. 3.  T.  4. F. 5. T. D.   1. A 
computer network comprises of at least two computers that 
are connected to each other so as to enable sharing of data 
and to facilitate communication between the computers 
in the network. Computers have wide variety of uses and 
hence are used at almost every place from offices, shops, 
homes etc. This has not only lead to better communication 
and networking but also an increase in human productivity. 
2. Linking different computers to each other creates a 
pattern. This pattern is known as a network topology. These 
computers when in a network are also called nodes. (i) Bus 
topology: When a single cable is used to connect all the 
computers in a network it is known as bus topology. (ii)
Ring topology: A closed ring like structure is formed in this 
topology hence the name ring topology every computer 
is connected to two other computers in this topology. (iii) 
Star topology: This topology forms a star by connecting a 
computer in the center to all other computers in this type 
of topology.(iv) Mesh topology: A mesh is formed when all 
computers in the topology are connected to one other. A full 
mesh topology is very expensive affair hence a partial mesh 
topology is generally used. 3. All computers in a computer 
network should have antivirus on them. As antivirus protects 
the computer from worms, Trojans and all other malware. It 
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warns you when your computer is infected and also clean up 
and deactivate the malicious software. 4. A firewall protects 
the computer from any unauthorized access. Firewall can be 
introduced in the computer as a software or hardware or a 
combination of both. All the data that enters or leave the 
computer goes through firewall so that it can be examined 
and the computer be protected. 5. (i) Hub: This is basically 
a device that is used to connect all the computers in a 
network. Hub receives the data from a computer sending 
it and sends the packets to all the computers connected in 
the network. The computer is individually responsible in the 
network tom determine which packets to accept and reject.
(ii) Switch: A switch is also used to connect the devices to 
a network. Switch is different from the hub as it directly 
sends the data meant for a computer to it and not to others. 
Switch has recorded addresses of all the computers with it. 
It analyses the destination after receiving data and send it 
to the desired destination directly.

.   E.  1. Software 2. NETWORK  3. Operating system 4. 
HUB. 5. TROPOLOGY 6. SWITCH 7. Joystick 8. ETHERNET 9. 
ROUTER 10. SECURITY    

chapter 2 : introducrtion to ms access 2013

A. 1. a. 2.  a. 3. a. 4. a. 5. c.  B. 1. Table  2. DBMS 3. Database   
4. Title Bar. 5. Interface C. 1. F 2. F 3. T 4. F 5. T  D. 1. A 
database is built up on tables and are used to store data. 
A table consists of rows and columns. There can be one or 
more tables in a database.  2. Records are rows in a table. 
The row is used to store complete information about an 
object or an item. 3. This is a filed or a combination of fields 
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that are used to uniquely identify records in a table. This 
key cannot have repetitive values and also cannot be left 
blank.  4. (i) Reduction in Data Redundancy (ii) Increased 
Consisitency and Reduced Update on Errors (iii) Improved 
Data Access to Users (iv) Maintaining Standards 5. An 
organized collection of data which can be managed and 
updated easily is known as database. DBMS is the short 
form for Database Management System. DBMS is a software 
program which is used to extract, create or modify data 
from a database. Relational, hierarchical, network are models 
on which the DBMS is based. A DBMS which is based on 
relational data is used to store data in form of tables and is 
known as relational database management system.

chapter 3 : advanced features of ms access 2013

A.  1. b 2. a 3. c 4. a 5. a B. 1. Query 2. Print command  3. 
four 4. Datesheet view 5. Print  C. 1. T 2. F 3. F  4.  F  5. 
F D. 1. The data that we create using tables and queries is 
presented in the form of a report. So, that it can be easily 
printed and viewed. For example, the report card that you 
get from your school or the invoice bill. To work on a report 
there are four views: •Report view •Print preview •Design 
view •Layout view 2. To enter, edit and view data a form 
provides an interface in a database table. A form constitutes 
textboxes and labels. We can work in different views in a 
form which are described below: •FORM VIEW •LAYOUT 
VIEW •DESIGN VIEW. 3. •Report view: This allows design 
related views only data can be viewed here.

•Print preview: This preview shows just before actual printing 
how your data will look once it gets printed.
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•Design view: No underlying data can be viewed here but 
only the structure of the report is available for viewing. You 
can also make changes but only those that can’t be made 
in the layout view.

•Layout view: This view displays data and allows you to make 
changes. For example, you can change the size of various 
controls here.

4. The query feature in MS ACCESS is used to get a limited 
amount of data based on a specific search criteria that we 
enter from one or more tables. For this a query can be 
designed which will search for all the data available on the 
criteria that is requested by the user. For example, you can 
design a query to search for students in your school who 
scored more than 60 percent marks.

chapter 4 : inserting images and creating Lists in htmL 

A. 1. a  2.  a  3.  a  4.  a 5. c B. 1. Overdered list 2. 
Unorded List 3. align 4. Alt 5. <oL> C. 1. F. 2. F 3. T 4. T 5. 
T  D. 1 Images in a webpage are used to enhance how the 
webpage looks and make the appearance of the webpage 
more appealing to the user <img> Tag is used to insert 
pictures in the webpage various attribute of <Img> Tag are  

Attribute Description Example
SRC This attribute defines 

the URL or the path 
of the image to be 
displayed. 

<IMG src= “rose.
jpg”>
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Height, 
width

This is used to define 
the height and the 
width of the picture in 
pixels.

<IMG height = 10 
width= 8>

Align Align attribute is 
used when aligning 
the image with respect 
to the margins or the 
inline texts.

• The left and 
right value will align 
the image with respect 
to the margins.

• The top, middle 
or bottom values will 
align with respect to 
the inline text. 

<IMG align= center>

Alt If the image is not able 
be displayed a text 
in its place, it will be 
displayed.

<IMG alt= “forest”>

Border This attribute specifies 
the border’s width 
around the image.

<IMG border=2>

2. These lists are numbered lists. They are used to rank the 
information in a specific numerical order. <OL> and </OL> 
tags enclose the ordered lists. To mark items the <L1> tag 
is used. The numbering style by default is 1,2,3. ordered lists 
are not ordered or numbered and in no specific order instead 
they are bulleted lists. To enclose them<UL> and </UL> 
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tags are used. 3. Align attribute is used when aligning the 
image with respect to the margins or the inline texts. •The 
left and right value will align the image with respect to the 
margins. •The top, middle or bottom values will align with 
respect to the inline text..  4.There will be times when you 
would want to form multilevel lists. To make them ordered 
and unordered lists are nested together which are known as 
nested lists. The following code is used to show this.

 <HTML>

 <BODY bgcolor = “magenta”>

 <H1 align = left> online book store</H1>

 Books are the best source of wisdom.

 <BR>

The different categories of books available in our online 
store are:

 <OL type =A>

 <LI> fiction

 <OL type=a>

 <L1> the little women

 <L1> the adventures of huckleberry Finn

 </OL>

 <L1> non fiction

 <UL type = square>

 <L1> mien Kamp

 <L1> the autobiography of Benjamin franklin
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 </UL>

 </OL>

 </BODY>

 </HTML>

5. 
If the image is not able 
be displayed a text 
in its place, it will be 
displayed.

<IMG alt= “forest”>

    chapter 5 :  creating and hyperLinks in htmL

A. 1. b 2. b 3. b 4. b 5. b  B. 1. Hyperlink 2. Name  3. <TH>  
4. <TR>  5. Table C. 1. F  2. F  3. T 4. F 5. F  D. 1. When you 
surf the internet you must have come across many images or 
text strings that open a different webpage. These are known 
as hyperlinks. Hyperlinks connect the webpages with each 
other over the World Wide Web. Anchor<a>Tag: To create 
hyperlinks in a webpage we use hyperlinks. Anchor tag is a 
container tag. If you enclose any text or image in the <A> 
and </A> tag. It will be displayed as hyperlink. 2. External 
linking: When you connect two different webpages, it is 
known as external linking. To click on a hyperlink we can see 
it has opens a new webpage to which the hyperlink is linked 
in the web browser. Pages within the same directory or any 
other page over the internet can be linked.Internal linking: 
Linking various sections of the same webpage is known as 
internal linking. This is used when a webpage is very long. 
This helps the user by quickly displaying the desired section 
of the webpage. So this save the user’s time and he quickly 
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views the information he is looking for.  3.Attributes of the 
<A> tag are given below:

Attribute Description
href The href attribute is used to indicate the 

destinaion of the link.
Name The name attribute links the sections on 

the same webpage. It also indicates the 
name of a section in a webpage.

 4. A table allows the user to present the data in a row and 
column format. Tables help in organizing the information on 
a webpage.

The following tags form are the structure of the table:

 1. <TABLE>…</TABLE>tags

 2. <TR> and</TR> tags

 3. <TD>and<TD>tags

The <TABLE> and</TABLE> tags are used at the start and 
the end of a table in HTML. The <TR> and </TR> tell about 
the number of rows in HTML. 5.When there is a need to 
merge data cells rowspan or colspan attributes are used. The 
data cells can be merged either row wise or column wise. 
<TABLE border=2 cellpadding=2>

<CAPTION>

Region wise sales report

</CAPTION>
<TR>
<TH> region</TH>
<TH> states</TH> 
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 <TH> units sold</TH>
</TR>
<TR>
<TH rowspan=3 bgcolor=”#99CCFF”> 
North</TH><TD>mumbai</TD>
<TD>1493</TD>
<TR> E. MS WORD, SAVE, NEW, CLOSE, DOCUMENT.

modeL test paper-i 

A. 1. a . 2. b 3. a. 4. b 5. b. 6. a 7. a 8. a  B. 1.Table 2. Firewall 
3. Tittle Bar 4. align 5. <TH> 6. Print 7. <OL>  C. 1. T 2. F 3. F 
4. F 5. F 6. T 7. T 8. T   D. 1 Images in a webpage are used to 
enhance how the webpage looks and make the appearance 
of the webpage more appealing to the user <img> Tag is 
used to insert pictures in the webpage various attribute of 
<Img> Tag are → 

Attribute Description Example

SRC This attribute defines 
the URL or the path 
of the image to be 
displayed. 

<IMG src= “rose.
jpg”>

Height, width This is used to define 
the height and the 
width of the picture in 
pixels.

<IMG height = 
10 width= 8>
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Align Align attribute is 
used when aligning 
the image with respect 
to the margins or the 
inline texts.

• The left and 
right value will align 
the image with respect 
to the margins.

• The top, middle 
or bottom values will 
align with respect to 
the inline text. 

<IMG align= 
center>

Alt If the image is not able 
be displayed a text 
in its place, it will be 
displayed.

<IMG alt= 
“forest”>

Border This attribute specifies 
the border’s width 
around the image.

<IMG border=2>

2.  1. A computer network comprises of at least two 
computers that are connected to each other so as to enable 
sharing of data and to facilitate communication between 
the computers in the network. Computers have wide 
variety of uses and hence are used at almost every place 
from offices, shops, homes etc. This has not only lead to 
better communication and networking but also an increase 
in human productivity.  3. •Report view: This allows design 
related views only data can be viewed here. •Print preview: 
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This preview shows just before actual printing how your data 
will look once it gets printed. •Design view: No underlying 
data can be viewed here but only the structure of the report 
is available for viewing. You can also make changes but only 
those that can’t be made in the layout view. •Layout view: 
This view displays data and allows you to make changes. For 
example, you can change the size of various controls here. 4. 
(i) Reduction in Data Redundancy (ii) Increased Consisitency 
and Reduced Update on Errors (iii) Improved Data Access 
to Users (iv) Maintaining Standards  5.  External linking: 
When you connect two different webpages, it is known as 
external linking. To click on a hyperlink we can see it has 
opens a new webpage to which the hyperlink is linked in 
the web browser. Pages within the same directory or any 
other page over the internet can be linked.Internal linking: 
Linking various sections of the same webpage is known as 
internal linking. This is used when a webpage is very long. 
This helps the user by quickly displaying the desired section 
of the webpage. So this save the user’s time and he quickly 
views the information he is looking for. 6.
If the image is not able 
be displayed a text 
in its place, it will be 
displayed.

<IMG alt= “forest”>

7. The query feature in MS ACCESS is used to get a limited 
amount of data based on a specific search criteria that we 
enter from one or more tables. For this a query can be 
designed which will search for all the data available on the 
criteria that is requested by the user. For example, you can 
design a query to search for students in your school who 



Computer (6-8) 49

scored more than 60 percent marks.  8.  .When there is 
a need to merge data cells rowspan or colspan attributes 
are used. The data cells can be merged either row wise or 
column wise. <TABLE border=2 cellpadding=2>

<CAPTION>

Region wise sales report

</CAPTION>

<TR>

<TH> region</TH>

<TH> states</TH> 

 <TH> units sold</TH>

</TR>

<TR>

<TH rowspan=3 bgcolor=”#99CCFF”> 

North</TH><TD>mumbai</TD>

<TD>1493</TD>

<TR> E. MS WORD, SAVE, NEW, CLOSE, DOCUMENT.        

chapter 6 : introduction to visuaL basic

A. 1. a  2. a 3. a 4. a 5. a  B. 1. IDE 2. Solution Explorer 3. 
Visual Basic 4. VB 5. Integrated Development Environment.   
C. 1. T 2. F  3. F 4. T  5. T  D. 1. You can create a calculator in 
visual basic to do so following steps are given below: Step 1: 
Using visual basic design a form interface as shown below: 
Step 2: The next step is changing the name property of the 
controls as shown below: a. Number1 Text box: txtNum1 b. 
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Number 2 Text box: txt Num2 c. Result Text ox: txtResult 
d. Add Button: cmdAdd e. Subtract Button: cmdsubtract f. 
Multiply Button: cmdMul. Step 3: Double-click on the Add 
button and type the given code in the cmdAdd_click() event 
handler.txtResult.Text= Val(txtNum1.Text)+ Val(txtNum2.Text)
A predefinedfunction Val is used to convert the values in 
the textboxes to numeric values for the purpose of addition 
otherwise the values inside the textboxes are treated as text 
values and are concatenated.Step 4: Now, add the given 
code in the cmdsub_click() event handler and cmdMul_ click() 
event handler.For subtraction txtResult.text=Val(txtNum1.
Text) – Val(txtNum2.Text)For MultiplicationtxtResult.text= 
Val(txtNum1.Text)* Val(txtNum2.Text). Step 5: Press F5 to run 
the project. The calculator form will appear as shown below. 
Now, Enter number 1 and number2. Click on different buttons 
for viewing the result. 2. Visual Basic is a programming 
language that offers a graphical user interface to design and 
develop programs while when you compare it to the other 
popular programming language that is widely used QBASIC 
it only offers a text based interface. Visual Basic provides 
the user with an integrated development environment to 
enable writing programs with ease. The IDE was created 
to offer an environment that is used for designing, editing 
and removing errors in programs easily. This language is 
also known as an event driven programming language. Any 
action of the user such as click or a key press is known as an 
event. The visual basic executes code statement in response 
to these events. 3. when you compare it to the other popular 
programming language that is widely used QBASIC it only 
offers a text based interface. Visual Basic provides the user 
with an integrated development environment to enable 
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writing programs with ease. The IDE was created to offer an 
environment that is used for designing, editing and removing 
errors in programs easily. This language is also known as 
an event driven programming language. Any action of the 
user such as click or a key press is known as an event. The 
visual basic executes code statement in response to these 
events. 4. To type code in visual basic we use the code view. 
The code can be typed inside event handlers of the form or 
even in other controls using this view. As soon as an event 
related to a project gets executed the event handler code 
gets executed. A list of all controls used in the current form 
is provided by a drop down list on the left. 5. The different 
files of a project are displayed by solutions explorer. There 
are view and the view designer buttons present on the top 
in the solutions explorer window which allow you to change 
to code view or to designer view. These views can be used 
to develop applications in visual basic.

chapter  7 : introduction to adobe photoshop cs6

A. 1. c 2. b 3. a 4. b 5. a B. 1. Selection 2. Color replacement 
3. Move 4.  Color replacement 5. crop  C. 1. F. 2. T. 3. F. 4. 
T. 5. F  D. 1. Color Replacement Tool: This tool allows you 
to replace the color of an image with the foreground color. 
Choosing this tool will change the mouse pointer to target 
symbol. Dragging the tool will pick up the sample color that 
is to be replaced. This color is replaced with the foreground 
color that you have selected. 2. Shape Tools : To draw shapes 
like rectangle, rounded rectangle, ellipse, polygon and line. 
Custom Shape Tool : There are a variety of preset shapes in 
Photoshop like a flower or a grid to use them we use this 
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tool.  3. Step 1:Starting Photoshop is very easy just drag the 
mouse pointer to the extreme left corner on your desktop. 
Step 2: Click on the Start button. Step 3: Now, click on All 
Programs. Click > Adobe Photoshop CS6.Step4: Photoshop 
will open. 4. (i) Marquee Tools: With this tool we can select 
the different portions of an image in a specific shape. (ii) 
Lasso Tools: Lasso tools are used so that we can select the 
different parts of a picture either by drawing a free hand 
or a straight edged area. (iii)Magic Wand Tool: Magic wand 
tool is used to select those areas of an image that have a 
similar color. The options that specify the exact selection can 
be selected from the options bar. (iv) Quick Selection Tool: 
To make quick selections on the image we use this tool. 
Once you click on this tool on the tools panel the cursor 
will change to a round brush tip. (v) Crop Tool : There are 
some parts in an image that are unwanted to remove them 
we use the crop tool.  (vi) Move Tool : This tool allows us 
to use the selected part of an image in a new location on 
that image. 5. Crops tools remove the unwamted parts of an 
usage where as move tool allows to use the selected part of 
an usage into a new. 

chapter 8 : more feature of adobe photshop

A. 1. a 2. a 3. a 4. a 5. a B. 1. Burn 2. Dodge  3. Blur  4. 
Clone stamp  5. Pattern stamp  C. 1. T. 2. F. 3. F. 4. T. 5.T D. 
1. Layers are used in Photoshop to work on an individual 
part or an element of an image. The composition of an 
image can be changed by changing the properties of layers. 
Elements that are placed on a higher layer are placed above 
the elements placed on a lower layer. 2. The appearance of 
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an image can be changed by adding special effects to it 
using filters. You can find the filters under the filter menu. 
There are various categories of filters like stylize, render etc. 
3.An image might be imperfect due to scratches, blemishes 
or marks on an image. To correct these imperfections we 
use the healing brush tool. To correct an image you can pick 
sample pixels from a portion of the image joining it to repair 
it. The healing brush tool allows you to match the texture, 
lighting, transparency, shading of the sampled pixels. Now, 
let us learn how to use this tool.4.Dragging across the eraser 
tool erases pixels across an image. If the layer is locked the 
pixels are erased to transparency or to the background color.  
5. Dodge and Burn Tool : These tools are used when images 
are to be lightened or darkened. The Dodge tool is used 
when lightening an image whereas the burn tool will darken 
them.

 chapter 9 : WindoW movie maker

A. 1. b 2. c 3. b 4. b 5. a B. 1. Movie 2. Transition  3. Movie  
4. Collection plane  5. WMX  C. 1. F. 2. T. 3. F. 4. F. 5.T  D. 
1Windows movie maker is a software that is designed by 
windows to allow users to edit audio or video files, arrange 
the content in the movie or create a movie altogether and 
even add sounds and transitions to it. 2.???3. Once you 
are done with your work in the windows movie maker, you 
can save your project for the following steps that are given 
below: Step 1: Click on the file > save movie file option. 
This will open the save movie wizard on the screen. Step 
2: Choose a location where you want the file to be saved 
and then click on the next button. Step3: Choose the name 
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of the file and enter it also. Choose the folder where you 
would like to save it. Then click on the next button. Step 
4: Choose your settings for saving the movie. The file gets 
saved by default in *wmv format but you can also save it 
in *avi or other formats. Now, click on the next button. 4. 
(i) Storyboard: This is also the view by default in windows 
movie maker. This can be found at the bottom of the screen. 
Storyboard has with it and displays all the pictures and the 
videos which are about to come in their proper sequence. 
(ii) Timeline: To switch to time line view you need to click 
on the show timeline button present above the storyboard. 
The timeline allows the user to review or modify clip timings 
in the movie. 5. (i) Movie Task Pane: This pane allows the 
user to perform functions like importing or adding videos 
or pictures to a project. You can also edit and add effects to 
a movie. (ii) Collections Pane: The toolbar has a collections 
tab clicking on which will open the collections pane. The 
collections pane has two part the left side and the right side. 
The left side has all the lists of collections whereas the right 
side has a selection of clips from the collection.

     modeL test paper-ii 

A. 1. b 2. a 3. a  4. b 5. b 6. a 7. a  8. c B. 1. Color 
replecement  2. Clone stamp  3. Solution explorer   4. Color 
replacement   5. Transition Effects 6. Visual Basic  7. *wmv 
8. Dodge  C. 1. F. 2. T. 3. F. 4. F. 5 .F 6. T 7. T 8. T Last night 
Jenny sang so well that everybody praised her. D. 1.To type 
code in visual basic we use the code view. The code can be 
typed inside event handlers of the form or even in other 
controls using this view. As soon as an event related to a 
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project gets executed the event handler code gets executed. 
A list of all controls used in the current form is provided 
by a drop down list on the left.   2. .An image might be 
imperfect due to scratches, blemishes or marks on an image. 
To correct these imperfections we use the healing brush 
tool. To correct an image you can pick sample pixels from a 
portion of the image joining it to repair it. The healing brush 
tool allows you to match the texture, lighting, transparency, 
shading of the sampled pixels. Now, let us learn how to use 
this tool. 3.  Shape Tools : To draw shapes like rectangle, 
rounded rectangle, ellipse, polygon and line. Custom Shape 
Tool : There are a variety of preset shapes in Photoshop 
like a flower or a grid to use them we use this tool.   4. 
(i) Storyboard: This is also the view by default in windows 
movie maker. This can be found at the bottom of the screen. 
Storyboard has with it and displays all the pictures and the 
videos which are about to come in their proper sequence. 
(ii) Timeline: To switch to time line view you need to click on 
the show timeline button present above the storyboard. The 
timeline allows the user to review or modify clip timings in 
the movie.  5.Dodge and Burn Tool : These tools are used 
when images are to be lightened or darkened. The Dodge 
tool is used when lightening an image whereas the burn 
tool will darken them. 6. The different files of a project are 
displayed by solutions explorer. There are view and the 
view designer buttons present on the top in the solutions 
explorer window which allow you to change to code view 
or to designer view. These views can be used to develop 
applications in visual basic. 7.  5. (i) Movie Task Pane: This 
pane allows the user to perform functions like importing or 
adding videos or pictures to a project. You can also edit and 
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add effects to a movie. (ii) Collections Pane: The toolbar has 
a collections tab clicking on which will open the collections 
pane. The collections pane has two part the left side and the 
right side. The left side has all the lists of collections whereas 
the right side has a selection of clips from the collection. 8. 
Crops tools remove the unwamted parts of an usage where 
as move tool allows to use the selected part of an usage 
into a new.

  


